LIMITED WARRANTY

CAMPBELL SCIENTIFIC, INC. warrants that the magnetic diskette on which the accompanying computer software is recorded and the documentation provided with it are free from physical defects in materials and workmanship under normal use. CAMPBELL SCIENTIFIC, INC. warrants that the computer software itself will perform substantially in accordance with the specifications set forth in the Operator's Manual published by CAMPBELL SCIENTIFIC, INC. CAMPBELL SCIENTIFIC, INC. warrants that the software is compatible with IBM PC/XT/AT and PS/2 microcomputers and 100% compatible computers only. CAMPBELL SCIENTIFIC, INC. is not responsible for incompatibility of this software running under any operating system other than those specified in accompanying data sheets or operator's manuals.

The above warranties are made for ninety (90) days from the date of original shipment.

CAMPBELL SCIENTIFIC, INC. will replace any magnetic diskette or documentation which proves defective in materials or workmanship without charge.

CAMPBELL SCIENTIFIC, INC. will either replace or correct any software that does not perform substantially according to the specifications set forth in the Operator's Manual with a corrected copy of the software or corrective code. In the case of significant error in the documentation, CAMPBELL SCIENTIFIC, INC. will correct errors in the documentation without charge by providing addenda or substitute pages.

If CAMPBELL SCIENTIFIC, INC. is unable to replace defective documentation or a defective diskette, or if CAMPBELL SCIENTIFIC, INC. is unable to provide corrected software or corrected documentation within a reasonable time, CAMPBELL SCIENTIFIC, INC. will either replace the software with a functionally similar program or refund the purchase price paid for the software.

CAMPBELL SCIENTIFIC, INC. does not warrant that the software will meet licensee's requirements of that the software or documentation are error free or that the operation of the software will be uninterrupted. The warranty does not cover any diskette or documentation which has been damaged or abused. The software warranty does not cover any software which has been altered or changed in any way by anyone other than CAMPBELL SCIENTIFIC, INC. CAMPBELL SCIENTIFIC, INC. is not responsible for problems caused by computer hardware, computer operating systems or the use of CAMPBELL SCIENTIFIC, INC.'s software with non-CAMPBELL SCIENTIFIC, INC. software.

ALL WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED AND EXCLUDED. CAMPBELL SCIENTIFIC, INC. SHALL NOT IN ANY CASE BE LIABLE FOR SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT, OR OTHER SIMILAR DAMAGES EVEN IF CAMPBELL SCIENTIFIC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

CAMPBELL SCIENTIFIC, INC. is not responsible for any costs incurred as result of lost profits or revenue, loss of use of the software, loss of data, cost of re-creating lost data, the cost of any substitute program, claims by any party other than licensee, or for other similar costs.

LICENSEE'S SOLE AND EXCLUSIVE REMEDY IS SET FORTH IN THIS LIMITED WARRANTY. CAMPBELL SCIENTIFIC, INC.'S AGGREGATE LIABILITY ARISING FROM OR RELATING TO THIS AGREEMENT OR THE SOFTWARE OR DOCUMENTATION (REGARDLESS OF THE FORM OF ACTION - E.G. CONTRACT, TORT, COMPUTER MALPRACTICE, FRAUD AND/OR OTHERWISE) IS LIMITED TO THE PURCHASE PRICE PAID BY THE LICENSEE.
LICENSE FOR USE

This software is protected by both the United States copyright law and international copyright treaty provisions. You may copy it onto a computer to be used and you may make archival copies of the software for the sole purpose of backing-up CAMPBELL SCIENTIFIC, INC. software and protecting your investment from loss. All copyright notices and labeling must be left intact.

This software may be used by any number of people, and may be freely moved from one computer location to another, so long as there is no possibility of it being used at one location while it’s being used at another. The software, under the terms of this license, cannot be used by two different people in two different places at the same time.
PC120 ETPRO FOR METDATA1, ET106, ET101, OR WEATHER WATCH 2000 WEATHER STATIONS
INSTRUCTION MANUAL TABLE OF CONTENTS

PAGE

1. SOFTWARE INSTALLATION ................................................................................. 1

2. THE ETPRO SHELL
   2.1 Mouse or Keyboard Operation ................................................................. 2
   2.2 The File Menu ......................................................................................... 2
   2.3 Creating the Weather Station Program .................................................... 2
   2.4 Setting Up Communication ....................................................................... 5
   2.5 Downloading the Program to the Weather Station ................................. 6
   2.6 Setting the Clock on the Weather Station .............................................. 7
   2.7 Real Time Weather Station Monitoring .................................................. 7
   2.8 Collecting Data from the Weather Station .............................................. 7
   2.9 Reports ................................................................................................. 8

APPENDICES

A. MAIN MENU OVERVIEW
   A.1 Brief Explanation of Headings ................................................................. A-1
   A.2 File .................................................................................................... A-1
   A.3 Edit .................................................................................................... A-1
   A.4 Maintenance ....................................................................................... A-1
   A.5 Data .................................................................................................... A-1
   A.6 Reports ............................................................................................... A-1

B. PROGRAM CUSTOMIZATION .................................................................... B-1
   B.1 Files Generated by ETPro ...................................................................... B-1
   B.2 Adding Sensors or Modifying Existing Measurements ............................ B-1
   B.3 Modifications to Split Parameter Files ................................................. B-2

FIGURES

1 Time Zone Map .............................................................................................. 1
2 ETPro Shell .................................................................................................. 2
3 Program Development .................................................................................. 3
4 Sensor Units Selection .................................................................................. 4
5 Communication Parameters .......................................................................... 6
6 Weather Station Real Time Monitoring ...................................................... 7
7 Hourly Summary Report ............................................................................... 8
8 Daily Summary Report .................................................................................. 9
PC120 ETPRO FOR METDATA1, ET106, ET101, OR WEATHER WATCH 2000 WEATHER STATIONS

ETPro is designed to calculate a potential evapotranspiration (ETo) value based on the Penman-Monteith Equation as well as show current weather station conditions. To use ETPro, PC208 software must be installed on the computer (PC208 manual installation Section 1.2.1). ETPro is contained on the disk labeled ETPro disk 1 of 1. The files on this disk must be copied to the directory where PC208 resides. The menu file allows the user to program the weather station based upon the station’s longitude, latitude, and elevation. The user may select the type of communication (phone modem or short haul modem) being used. ETPro also allows monitoring real-time measurements, collecting data, and generating reports from an easy-to-use software working environment.

NOTE: Time zone coordinates are vital in accurate ET0 calculation. A time zone map (Figure 1) is provided for use in determining in which time zone the weather station is located.

1. SOFTWARE INSTALLATION

Insert the ETPro disk into drive A or B of the computer. Copy all files from this disk to the same directory where PC208 resides.

For example, if the ETPro disk is in drive A and the directory where the PC208 software resides is C:\PC208, then move to the C:\PC208 directory. From the C:\PC208> prompt, type “copy a:*.*” and press <Enter>. All files will be copied from the A drive to the C:\PC208 directory.

FIGURE 1. Time Zone Map
2. THE ETPRO SHELL

1. Move to the directory where the ETPro files are located. From the DOS prompt, type "et" and press <Enter>. The screen that appears should look like Figure 2. This screen is referred to as the ETPro shell, or simply as the shell.

NOTE: DO NOT run the shell from Windows 3.1. The shell could act erratically. Make sure Windows 3.1 has been completely shut off and that the shell is running purely through DOS.

2.1 MOUSE OR KEYBOARD OPERATION

Menus and sub-menus can be selected by clicking on them once with the left mouse button.

If a keyboard is used, press the <Alt> key. Notice a specific letter will change color in each of the menus. To activate a particular menu, press the letter on the keyboard that matches the color-changed menu letter or press the right or left arrow key to move to the appropriate menu and press <Enter> to select it.

The sub-menus will automatically come up with a color-changed letter once the main menu item has been selected.

For individual selection, press the matching letter on the keyboard or use the up and down arrow keys to move to the appropriate sub-menu and then press <Enter> to select it.

2.2 THE FILE MENU

2.2.1 "About" Sub-menu

A brief description of ETPro will appear by selecting the "File" menu and the "About" sub-menu.

2.2.2 Exiting ETPro

ETPro will exit to the DOS prompt by selecting the "File" menu and the "Exit" sub-menu. This is the way to exit out of ETPro.

2.3 CREATING THE WEATHER STATION PROGRAM

1. Select the "Edit" menu and the "Create Station Program" sub-menu from the shell.

2. A window will appear welcoming you to ETPro and asking whether you have a color monitor. Default is "Y". Press <Enter> if you have a color monitor.

Type "n" or "N" and press <Enter> if you do not have a color monitor (monochrome display).
3. The next window should appear similar to Figure 3. The default settings are as follows with alternate selection in parenthesis:

- Enclosure Relative Humidity Sensor: Yes (No)
- Soil Temperature Probe: N (Y)
- ETo Calculation: Y (N)

Weather station model can be changed by either clicking on the entry with a mouse or by using the up or down arrow keys on the keyboard to move to the correct entry and pressing <Enter> to select it. The small box at the bottom of this window has a brief explanation on the entry being selected.

Selecting a particular station model will also bring up the default sensor array for that station in the sensor units selection window.

**NOTE:** The “Enclosure Relative Humidity Sensor” entry can only be changed from within the “Weather Station Model” entry. The “Enclosure Relative Humidity Sensor” will default to “Yes” if the MetData1, ET106, or ET101 weather station is selected.

To change “Soil Temperature Probe;” or “ETo Calculation;” a “Y”, “y” or “N”, “n” must be entered from the keyboard into the appropriate box.

Selecting no ETo calculation will set the 24 hour data collection at midnight.

4. Sensor units can be viewed or changed by selecting the “Sensor Units” entry. A window should appear similar to Figure 4.
**NOTE:** If a W2000, ET106, or ET101 weather station is being used, it MUST have the same type of sensors as described in this window. The program generated by this part of ETPRO is based on a specific sensor array. You will need to manually make changes to the program after it has been created using ETPRO if you are using a different complement of sensors. **SEE APPENDIX B FOR INFORMATION ON CUSTOMIZATION.**

The right side of the sensor units window indicates the values that are being saved to hour (60 minutes) and 24 hour (1440 minutes) final storage.

The box in the lower, right-hand corner of the sensor units window gives a brief explanation on entries being selected.

5. Default sensor selections for the individual weather stations are as follows:

**METDATA1**
- Temp/%RH - HMP45C
- Wind Speed and Direction - Met One 034A
- Solar - LI200X
- Precipitation - TE525
- Soil Temp - 107 (if used)

**ET106**
- Temp/%RH - CS500
- Wind Speed and Direction - Met One 034A
- Solar - LI200X
- Precipitation - TE525
- Soil Temp - 107 (if used)

**ET101**
- Air Temp - CS200
- Wind Speed and Direction - Not Applicable
- Solar - LI200X
- Precipitation - Not Applicable
- Soil Temp - 107 (if used)

**W2000**
- Temp/%RH - HMP35C
- Wind Speed and Direction - RM Young
- Wind Sentry 03001
- Solar - LI200X
- Precipitation - TE525
- Soil Temp - 107 (if used)

*Except for the soil temperature probe, these stations are preconfigured and shipped with this set of sensors.*

**NOTE:** Only select different sensors when you are certain of what your particular station is using. Selecting the incorrect sensor can result in incorrect measurements by the weather station.

6. Latitude and Longitude will require knowing whether the site is North or South of the equator for latitude (for example, a site in Logan, Utah would be 41.784° N), and whether the site is East or West of the Greenwich Meridian for longitude (for example, the same site in Logan, Utah would be 111.85° W). These entries must be entered in ETPRO as decimal degrees NOT degrees - minutes - seconds.
NOTE: The location of the site must be known within a degree for both latitude and longitude for accuracy in the ETo calculation.

7. Elevation can be entered as feet or meters.

NOTE: The elevation of the site must be known within a hundred feet (30 meters) for accuracy in the ETo calculation.

8. Once all the sensor models and units have been entered, select "Done" to go back to the first ETPro program development screen (Figure 3). Press the <F4> key to create the weather station program as well as several other files used by ETPro. Depending on the computer, it might take several minutes for this part of program creation to finish.

NOTE: See Appendix B.1 for a listing of all the files created.

A window will appear that explains how long the datalogger will collect data before it begins overwriting old data. These numbers are for a standard CR10. This number can be doubled if the weather station is using a CR10X.

A number will also appear that relates to the time the datalogger clock is set in relation to Greenwich time. THE DATALOGGER MUST BE SET TO STANDARD TIME. If you are in doubt whether you are on standard or daylight savings time, call NIST at (303) 499-7111, which is a recording of universal time. Once each minute you will hear the current universal time local to Greenwich, England. With this time you can refer to the time zone map (Figure 1) and count back the number of hours you are from Greenwich. For example, Logan, Utah is 7 hours from Greenwich. Therefore, if the time heard was 1500 hours, the proper time at the station is 1500 - 7, or 8:00 A.M. Set the computer that will be communicating with the weather station to this time.

Press the <Enter> key to return to the shell.

2.4 SETTING UP COMMUNICATION

1. Select the "Edit" menu followed by the "Communication Param." sub-menu from the shell.

2. A window will appear as shown in Figure 5. A mouse will not work in this window. Use the up and down arrow keys to move around.

3. Notice the COM Port being used. Default is COM1. If your computer is using some other COM Port, move the cursor down to COM1 and press the <space> bar until the proper COM Port appears.

4. Communications baud rate can be left at 9600 for RAD short haul modem. For phone modem, change the baud rate to 1200 baud by moving the cursor to this section and pressing the <space> bar until 1200 appears.

5. Move the cursor below the line that says "Interface Device". It will come up with "#1: End". If a RAD modem is being used, press the <space> bar until "RAD Modem" appears.
FIGURE 5. Communication Parameters

If a phone modem is being used, press the <space> bar until “Hayes Modem” appears. Press the <Enter> key and type in the correct phone number for the weather station. You may need to modify the MODEM.INI file in the PC208 directory to work with your particular phone modem or make some other changes to accommodate your modem. SEE THE PC208 MANUAL FOR FURTHER ASSISTANCE.

Press <Enter> after RAD Modem or Hayes Phone Modem with the phone number has been selected. “#2: End” should appear on the screen. To save the entries, press and hold down the <Ctrl> key, press the <F> key, and release both keys simultaneously.

2.5 DOWNLOADING THE PROGRAM TO THE WEATHER STATION

1. The program can be downloaded after the weather station has been installed and powered up. Make sure the computer clock is set to the correct date and standard time.

   Select the “Maintenance” menu option followed by “Download Station Program” from the shell.

2. Click with a mouse the button marked “OK to set clock” or tab over to it and press the <Enter> key to select.

The computer screen will change to yellow lettering on a black screen. There is no communication going on between the computer and the weather station if the cursor just blinks in the upper left hand corner. SEE THE WEATHER STATION INSTALLATION MANUAL FOR COMMUNICATION TROUBLESHOOTING TIPS.

The screen should begin to fill with “220 bytes sent, received, entered.”

This indicates the program is being sent to the weather station. Eventually this will stop and the screen will return to the shell.

NOTE: It’s a good idea to go into monitor mode after a program has been downloaded. There will not be any hourly values until the top of the hour, or 24 hour values until the time that was set for the 24 hour data storage to take place. You may have to wait as long as 20 seconds before sensor values appear.

WARNING: The data that was previously stored in the datalogger will be lost if a program is accidentally downloaded to a station that is already running. Keep this in mind if you are planning on making changes to an existing program and downloading the new program to a station that is already running.
2.6 SETTING THE CLOCK ON THE WEATHER STATION

1. The weather station's clock is more accurate than the clock in most computers. Make sure the time and date on the calling computer is correct and set to standard time if the weather station clock is definitely incorrect.

2. Select the "Maintenance" menu followed by the "Set Clock" sub-menu from the shell.

3. Click on "OK to set clock" with a mouse or press the <Enter> key. This will automatically call the weather station and set the date and time.

2.7 REAL TIME WEATHER STATION MONITORING

1. Select the "Data" menu and the "Monitor" sub-menu from the shell.

2. The computer will call the weather station and a screen similar to Figure 6 should appear.

The values in the left column are updated every 10 seconds; the values in the center column are updated on an hourly basis; and the values in the right-hand column are updated every 24 hours at the time that was set while creating the program.

3. Press the <Esc> key to exit weather station monitoring. The program will return to the shell.

2.8 COLLECTING DATA FROM THE WEATHER STATION

1. Select the "Data" menu and the "Collect Data" sub-menu from the shell.

2. The computer will call the weather station, collect data to a file called "WEATHER.DAT", and return to the shell.

NOTE: The WEATHER.DAT file gets data appended to it every time the station is called. This file will continue to grow every time the weather station is called and data is uploaded to the computer. It is advisable to archive this file once a year to a separate floppy disk that is marked with the start and stop date for the data file and delete the old data file off of the computer's hard drive. The weather station will automatically create a new WEATHER.DAT file the next time it is called.

---

**FIGURE 6. Weather Station Real Time Monitoring**

---
2.9 REPORTS

2.9.1 Hourly Reports

1. Select the "Reports" menu followed by the "Hourly Summary" sub-menu from the shell. A screen should appear similar to Figure 7.

2. The various start and end conditions can be selected by clicking on them with a mouse or pressing the <Tab> key to move to the correct condition. The condition can be changed by using the <Delete> key or the <Backspace> key. Type in the correct start and end conditions. Time must be entered in 24 hour hourly increments. For example, 2:00 P.M. would be entered as 14.

WARNING: The start condition must exist in the data set or no report will be generated. For example, if the WEATHER.DAT file starts with data from 8/11/1995 @ 17:00 hours and 16 is selected as the start hour, then NO report will be generated even though there is data after this time period.

**NOTE:** The report generator will stop and NOT report on the end condition specified. For example, to see data up to 2:00 P.M. today, enter 15 (3:00 P.M.) as the end hour condition. An end condition can be entered that doesn't exist and the report will still run. While the report is being generated, a warning message will flash at the top of the screen. Press the <Esc> key to get past the message and finish generating the report.

"Report Destination" specifies whether the report should go to the screen to be viewed or to the printer for a hard copy. Click with a mouse between the parentheses to specify which one you want or move to this section using the <Tab> key and use the right and left arrow keys to select which one you want.

3. After all the start and end conditions have been entered and the report destination is set, click on the "OK" button or tab over to "OK" and press <Enter> to run the report.

The screen will change and at the top of the screen numbers will appear and run by. The larger the WEATHER.DAT file, the longer it will take the report to be generated for recent data. The <Page Up> and <Page Down> keys can be used to view the entire report if the report was sent to the screen. Press the <Esc> key to exit the report and return to the "Hourly Summary Report" window.

**FIGURE 7. Hourly Summary Report**
ETPro will automatically insert page numbers and page breaks into the report if the report was sent to the printer.

ETPro will return to the "Hourly Summary Report" screen after the report has been run. Select "Cancel" to return to the shell.

A file called "HOURLY.PRN" will be generated by ETPro and put on the hard drive in the same directory where ETPro resides. This file is a simple field formatted ASCII text file and can be imported into a spreadsheet package.

Columns in the reports can be modified. If this is required, see Appendix B.

2.9.2 Daily Reports

1. Select the "Reports" menu followed by the "Daily Summary" sub-menu from the shell. A screen should appear similar to Figure 8.

2. The various start and end conditions can be selected by clicking on them with a mouse or pressing the <Tab> key to move to the correct condition. The condition can be changed by using the <Delete> key or the <Backspace> key. Type in the correct start and end conditions.

WARNING: The start condition must exist in the data set or no report will be generated. For example, if the WEATHER.DAT file starts with data from 8/11/1995 and 10 is selected as the start day, then NO report will be generated even though there is data after this time period.

NOTE: The report generator will stop and NOT report on the end condition specified. For example, to see data up to the fifth day of the month, enter six as the end condition. An end condition can be entered that doesn't exist and the report will run. While the report is being generated, a warning message will flash at the top of the screen. Press the <Esc> key to get past the message and finish generating the report.

"Report Destination" specifies whether the report should go to the screen to be reviewed or to the printer for a hard copy. Click with a mouse between the parentheses to specify which one you want or move to this section using the <Tab> key and use the right and left arrow keys to select which one you want.

3. After all the start and end conditions have been entered and the report destination is set, click on the "OK" button or tab over to "OK" and press <Enter> to run the report.

FIGURE 8. Daily Summary Report
The screen will change and at the top of the screen numbers will appear and run by. The larger the WEATHER.DAT file, the longer it will take the report to be generated for recent data.

The <Page Up> and <Page Down> keys can be used to view the entire report if the report was sent to the screen. Press the <Esc> key to exit the report and return to the "Daily Summary Report" window.

ETPro will automatically insert page numbers and page breaks into the report if the report was sent to the printer.

ETPro will return to the "Daily Summary Report" screen after the report has been run. Select "Cancel" to return to the shell.

A file called "DAILY.PRN" will be generated by ETPro and put on the hard drive in the same directory where ETPro resides. This file is a simple field formatted ASCII text file and can be imported into a spread sheet package.

Columns in the reports can be modified. If this is required, see Appendix B.
APPENDIX A. MAIN MENU OVERVIEW

A.1 BRIEF EXPLANATION OF HEADINGS

ETPro has five main menus: File, Edit, Maintenance, Data, and Reports.

A.2 FILE

About
Exit

ABOUT: Shows the version number and provides a brief description of ETPro.
EXIT: Exits the ETPro shell and returns to DOS.

A.3 EDIT

Create Station Program
Communication Param.

CREATE STATION PROGRAM: Generates the program for the weather station based on user inputs and selections. By default, sensor units are in SI units. Press F1 in this program for help.

COMMUNICATION PARAMETERS: Creates unique weather station communication parameters based on user input. This section is used to define whether the station is using a RAD short haul or a phone modem for communication.

A.4 MAINTENANCE

Set Clock
Download Station Program

SET CLOCK: Sets the weather station clock to the time on the calling computer.

DOWNLOAD STATION PROGRAM: Sets the weather station clock to the time on the calling computer as well as downloads the program to the weather station created in the "Create Station Program" explained in Section 1.2.2.2.

A.5 DATA

Monitor
Collect Data

MONITOR: Allows the user to monitor real time weather station data.

COLLECT DATA: Retrieves the hourly and daily data from the weather station.

NOTE: Data collection IS NOT automatic. The "Collect Data" sub-menu item must be used in order to collect the most recent data.

A.6 REPORTS

Hourly Summary
Daily Summary

HOURLY SUMMARY: Creates a user defined time period report based on hourly weather station data.

DAILY REPORT: Creates a user defined time period report based on daily weather station data.
APPENDIX B. PROGRAM CUSTOMIZATION

NOTE: It is assumed that the user is familiar with PC208 software, particularly Edlog, GraphTerm, and Split. Call CSI for support if you are unable to figure out how to get a specific modification to work.

B.1 FILES GENERATED BY ETPRO

ETPro automatically generates several files when a program is created. ETPro works with most of these files when generating reports, calling the weather station, or downloading a program. These same files are what need to be modified for any customization. The files and a brief explanation are as follows:

- **WEATHER.DLD** - program file downloaded to the weather station via GraphTerm.
- **WEATHER.STN** - station file used by GraphTerm and Telcom for communicating with the weather station.
- **WEATHER.LOC** - used with the station file by GraphTerm. This file determines what input locations will appear on the computer screen while in monitor mode.
- **HOURLY.PAR** - SPLIT parameter file used for creating hourly reports.
- **DAILY.PAR** - SPLIT parameter file used for creating daily reports.
- **STATUS.PAR** - SPLIT parameter file used to show status of the CR10 datalogger, battery voltage, and enclosure relative humidity (if used). This file is used automatically when the daily report is run.
- **ETPRO.FIL** - this is a text file that can be printed out. It shows all the input locations and labels being used by the weather station as well as what data is being sent on an hourly and daily basis to final storage.
- **ETPRO.ANS** - this file contains all the previous selections to the ETPro program generator. This file is loaded by ETPro every time a program is created so that the user can view previous selections.

B.2 ADDING SENSORS OR MODIFYING EXISTING MEASUREMENTS

NOTE: If the program is being adapted to accommodate a sensor that makes the same type of measurement as one of the default sensors, use the same input location as the sensor that is being replaced. Make sure the WEATHER.DLD file was generated using the correct units for the measurement before modifications are made.

1. Use Edlog to document the WEATHER.DLD file.

2. Make any modifications to the existing program that is necessary to accommodate new sensors or change the existing sensor measurement.

WARNING: Put all new input locations at the end of the existing input location list. Adding input locations in the middle of the input location list can seriously disturb final storage outputs being sent to input locations for monitoring.

3. Save the changed program under the name of WEATHER. Older versions of Edlog will add the .DLD extension, whereas newer versions of Edlog will add the .CSI extension. Compile the program. Both programs will create a WEATHER.DLD file after compilation.

4. To protect the program from someone inadvertently creating a new program from the ETPro shell, copy the changed program WEATHER.DLD to WEATHER.ARC.

5. Use a text editor or word processor to modify the ETPRO.FIL file with the changes made to the program. After this has been done, save the file under the same name (ETPRO.FIL) and make a copy to ETPRO.ARC. This will protect the file from a mishap as described in #4.
APPENDIX B. PROGRAM CUSTOMIZATION

B.3 MODIFICATIONS TO SPLIT PARAMETER FILES

1. The three parameter files listed in B.1 can be modified using SPLIT if different final storage data is to be viewed. Keep in mind not to exceed 11 columns in a report and to limit all decimals to two places maximum.

2. To preserve the changes from mishap, copy each of the altered parameter files to files with an .ARC extension.

B.4 VS1

NOTE: It is assumed that the user has gone through the VS1 manual and knows how to use the VS1 editor.

1. The VS1 editor can be used after the WEATHER.DLD file has been created. Follow the instructions in the VS1 manual. Copy the altered WEATHER.DLD file to WEATHER.ARC for protection.

2. Modify the WEATHER.STN file to accommodate the commas and *9 at the end of the station’s phone number to switch the voice off and turn the data modem on.

NOTE: If multiple users are using this station, set up the VS1 file as COMMERCIAL MODE to prevent outside callers from modifying any flags or ports.

For another layer of security, consider putting a security code in the first parameter of *C mode to prevent anyone from downloading a different program. The security code used with the *C mode will also need to be put in the WEATHER.STN file. Keep in mind that the security code used with the VS1 in COMMERCIAL MODE is a separate code from what is used with the *C mode. SEE CR10(X) and VS1 manuals for details. BE EXTREMELY CAREFUL NOT TO LOSE THE SECURITY CODE NUMBERS.

B.4.1 VS1 WITH CALLBACK

1. Read what is written for a standard VS1 above.

2. VS1 with callback can be tricky at best. If the manual is unclear, then call CSI for support.